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ABBREVIATIONS 

DOI Digital Object Identifier, permalink to digital source 

EKI Institute of the Estonian Language (Eesti Keele Instituut) 

EAVA Estonian Aviation Academy 

ESTERM Institute of the Estonian Language's multilingual terminology database 

EANS Estonian Air Navigation Services 

ILS Instrument Landing System 

PDF Portable Document Format 

RT State Gazette (Riigi Teataja), official online publication of the Republic of Estonia 
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INTRODUCTION 

The written assignments of the learners reflect the acquired knowledge and skills in discussing 

practical and theoretical issues. Compliance with formal requirements in written assignments is just 

as important as the content of the work. 

The guidelines for formatting written assignments at the Estonian Aviation Academy (hereinafter 

referred to as the Academy) have been compiled to standardise the structure and format of the papers 

submitted by the students. All written assignments, including research papers and graduation theses, 

prepared by students of the Academy should follow these guidelines. Examples shown in this manual 

are presented in a light grey box. The technical instructions have been prepared on the assumption 

that the learner uses the word-processing software MS Word. The instructions indicate the relevant 

technical solutions of MS Word in English (File → Options → Language → Office display 

language). 
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1 CLASSIFICATION OF WRITTEN ASSIGNMENTS 

Written assignments, for these guidelines, are divided into short written papers (1–3 pages) and 

long written papers (more than 3 pages). 

For a short written paper, the title page is not formally required. The work is titled using an 

unnumbered second-level heading (Heading 2), aligned to the left. The student's name, course, field 

of study, and date of submission are added to the right side of the document header (see Annex 9). 

A longer written paper must include at least a title page, table of contents, introduction, main 

content chapters, summary, and list of references. According to the rules for organising activities 

related to graduation theses and final exams, the main content of the thesis (introduction, content 

chapters, and summary) should be about 20–25 pages (Estonian Aviation Academy, 2025). Annexes 

are not part of the main content, and their volume is not limited. 

A research paper (incl. thesis) consists of the following parts:  

● title page (see Annex 1 and Annex 2), 

● the author's declaration and the supervisor's confirmation of admission to the defence of the 

graduation thesis (see Annex 3 and Annex 4), 

● a brief summary of the work in Estonian (see Annex 5), 

● table of contents, 

● abbreviations (optional; must be included if more than ten abbreviations or symbols are used), 

● introduction (description of the research problem, the aim of the work, research questions or 

hypotheses), 

● theoretical overview (based on at least ten sources, at least three of which must be scientific 

articles), 

● empirical part (description of the methodology, results, and their analysis, conclusions, 

discussion), 

● summary (the aim of the work, main results, answers to research questions, 

confirmation/refutation of hypotheses, practical application, and further development of the 

work), 

● references (a list of used sources), 

● annexes (if applicable), 

● non-exclusive licence to reproduce the thesis and make it available to the public (see Annex 

6, Annex 7, and Annex 8). 
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2 GENERAL REQUIREMENTS  

2.1 Page format and borders 

Written assignments are generally submitted electronically as PDF files in A4 format (210 x 297 

mm). All pages must have margins of 2 cm on the top, bottom, left, and right (Layout→ Margins → 

Custom Margins). 

All pages, except the title page, must be numbered, with the page number centered at the bottom of 

the page. The title page is included in the page count; however, the page number must not be 

displayed on the title page (Insert → Page Number → Different First Page). 

2.2 Style and language 

Linguistic and stylistic accuracy is essential in academic writing. The language must be formal and 

academic, and appropriate professional terminology must be used. The style and form of writing 

must be consistent throughout the entire work. Authors are expected to maintain an objective position 

and should avoid adopting a one-sided personal standpoint. Instead of personal pronouns, such as "I" 

and "we" (e.g. "I analysed", "we investigated"), the impersonal or passive form should be used 

(e.g. "the work discusses, analyses, examines, evaluates" or "has been discussed, analysed, 

evaluated”). A definite and assertive mode of expression is recommended, as excessive use of 

conditional speech may suggest the author’s lack of confidence or uncertainty in the validity of their 

arguments. 

Discipline-specific terminology must be used accurately and consistently, based on authoritative 

sources such as specialised dictionaries, glossaries, standards, and relevant academic literature. 

When determining appropriate terminology in Estonian (for the short summary in Estonian), the 

language portal Sõnaveeb of the Institution of the Estonian Language (hereinafter EKI) should be 

used. This portal integrates all major dictionaries and recent terminological databases, including the 

former Institute of the Estonian Language's multilingual terminology database ESTERM. EKI 

terminologists regularly update and revise the terminology resources (Institute of the Estonian 

Language, 2024). 

2.3 Headings and table of contents 

Each independent main section of the work (table of contents, short summary in Estonian, 

introduction, main content chapters, summary, list of references) must begin on a new page 

(Insert→Page Break). 
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References are not included in headings, and abbreviations should be avoided if possible. No 

punctuation should be added at the end of the title. Headings are to be formatted using an automatic 

heading style system (Heading 1, Heading 2, Heading 3) to enable automatic generation of the table 

of contents. 

The titles are formatted as follows: 

Heading 1 (Example 1): font Times New Roman, font size 16 points, colour black, bold (Bold), 

a continuous capital letter (UPPERCASE), line spacing 1.5 (Line Spacing), paragraph spacing 

before and after 6pt (Layout → Spacing), alignment to the left. Each main chapter starts on a new 

page (Line and Page Breaks → Page break before). 

Example 1. First-level heading 

1 CHAPTER TITLE 

Heading 2 (Example 2): font Times New Roman, font size 14 points, colour black, bold, first word 

capitalised, subsequent words in lowercase (Sentence case), line spacing 1.5, paragraph spacing 

before and after 6pt, alignment to the left. 

Example 2. Second-level heading 

1.1 Chapter title 

Heading 3 (Example 3): font Times New Roman, font size 12 points, colour black, bold, first word 

capitalised, subsequent words in lowercase, line spacing 1.5, paragraph spacing before and after 6pt, 

alignment to the left. 

Example 3. Third-level heading 

1.1.1 Chapter title 

The table of contents is generated automatically. It displays all full headings with sequential numbers 

and corresponding page numbers. For graduation theses, the table of contents is placed after the 

summary in English; for term papers, it follows the title page. 

The table of contents is formatted as follows: font Times New Roman, font size 12 points, colour 

black, line spacing 1, paragraph spacing 6pt. 

2.4 Formatting the text 

The text must be formatted as follows: font Times New Roman (incl. in tables, figures, and formulas), 

font size 12 points, colour black, line spacing 1.5, paragraph spacing before and after 6pt, text 

alignment must be justified (Justified), and indentations should not be used. In case of unjustified 

gaps in the text, hyphenation should be applied (key combination <Ctrl>+ <−>).  
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3 REFERENCING  

3.1 Referencing styles 

Various referencing styles exist, but only one style must be used consistently throughout a single 

work. The following referencing styles are permitted for formatting of the Academy's written 

assignments: 

● name and year citation (APA style) – commonly used in social science and humanities; 

● numerical referencing (IEEE style) – commonly used in engineering and natural sciences. 

In APA Style the in-text reference is placed in brackets and includes the author's surname, year 

of publication, and, where appropriate, the page number if a specific passage is cited (Example 

7). If the source has no author, the reference begins with the title. If there are three or more 

authors, in-text citation names only the first author’s Surname followed by “et al.”. For works 

by the same author published in the same year, a lowercase letter is added after the year (both 

in-text and in the reference list) to distinguish the sources, e.g., 2021a, 2021b, etc. 

The list of references at the end of the work is arranged alphabetically by the author's surname. 

Each entry starts with left alignment, with the second and subsequent lines indented by 1.5 cm 

(Hanging indent). Line spacing should be 1.5, with no blank lines between entries. 

APA reference entry consists of four main components (Example 4): 

Author, A. (year). Title. Source. 

Author – the individual(s) or organisation responsible for the work. Presented as: surname, 

initial(s) of the first name. If the author is absent, the entry begins with the title. If there are more 

than 20 authors, the first 19 are listed, followed by an ellipsis ... and the last author. 

Year – the year of publication, enclosed in parentheses. For web content with changing dates 

(e.g., news articles, blogs, social media posts), the full date or month should be included. (year, 

day. month). If no date is available, the "no date" is used in parentheses (n.d.). 

Title – the title of the work. 

o Titles of standalone works (e.g., books, magazines, journals, reports, web pages) are 

italicised. 

o Titles of articles, book chapters, subpages of a web page, or blog posts are presented in 

regular type. 

Source – details enabling the reader to locate the work. This may include, depending on the 

source: edition information in brackets after the title (if not first edition); journal title, volume 
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and issue numbers; page or article numbers (for articles or book chapters), publisher, DOI or 

URL. DOI is always preferred over URL. 

Example 4. Key components of an APA reference entry for a book and a journal article 

Book: 

Author, A. (year). Title of the book. (#th ed.). Publiser. DOI or URL (if applicable) 

Bartsch, R. (2018). International aviation law: A practical guide (2nd ed.). Routledge. 

Journal article: 

Author, A. A., Author, B. & Author, C. (year). Title of the article. Title of the Journal, 

volume(Issue), Article number or page range. DOI or URL 

Xiong, M., Wang, H., Hou, Z., & Wong, Y. D. (2025). Multi-level information identification 

for civil aviation safety risks: A hierarchical multi-branch deep learning approach. Information 

Sciences, 702, 121888. https://doi.org/10.1016/j.ins.2025.121888 

In IEEE Style, the in-text references are indicated by a number in square brackets and, where 

relevant, by page numbers (Example 5). In the list of references at the end of the work, sources are 

numbered in the order in which they are first cited in the text. 

Example 5. In-text referencing in IEEE-style 

Submitting someone else's work as one’s own constitutes plagiarism [1]. 

Submitting someone else's work on your own behalf when citing is plagiarism [1, p. 35]. 

An IEEE reference entry in the list of references also consists of four main components; however, its 

structure differs from that of APA style (Example 6): 

A. Author, Title or “Title”. Source. Date of publication. 

Author(s) – the individual(s) or organisation responsible for the work. Presented as: Initial(s). 

Surname. If there are more than six authors, only the first author is listed, followed by et al. If the 

author is unknown, the entry begins with the title. 

Title – the title of the work. 

o Titles of books, journals, conference proceedings, and standards are italicised, with all major 

words capitalised (Capitalise Each Word). 

o Titles of articles, chapters, patents, reports, and dissertations are enclosed in quotation marks, 

with capitalisation limited to the first word (Sentence case). 
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Source – information enabling the reader to locate the referenced work. This may include the journal 

or conference title (in italics), book edition (if not the first edition), place of publication (including 

the state for U.S. publications), publisher, volume or issue number, page range, or article number. 

Date of publication – the year of publication of the work is placed at the end of the reference. For 

journal articles, the month of publication should be included. If the same issue has two months listed, 

the months should be separated by a slash (e.g., Jul./Aug.). 

For online sources, the date of access is added at the end of the reference in the format: Accessed: 

Month (abbrev.). Day, Year, followed by [Online]. Available: URL. If a DOI is provided, it should 

be used instead of a URL; in such cases, [Online], Available:, and the access date are omitted, and 

the DOI must end with a full stop (reference that ends with a URL does not end with a full stop). 

Example 6. Key components of an IEEE reference entry for a book and a journal article 

Book: 

[#]  A. A. Author, Book Title: Subtitle, #th ed. Place of publication, State (if applicable): Publisher, 

Year. 

[#] R. Bartsch, International Aviation Law: A Practical Guide, 2nd ed. London, U.K.: Routledge, 

2018. 

Journal article: 

[#]  A. Author, B. B. Author, and C. Author, "Article title: Subtitle," Publication Title, vol. #, no. #, 

pp. xxx-xxx, Abbrev. month, Year, Art. no. xxxx, doi: xxxx. Or Accessed: Month. day, year. 

[Online]. Available: URL 

[#] M. Xiong, H. Wang, Z. Hou, and Y. D. Wong, "Multi-level information identification for civil 

aviation safety risks: A hierarchical multi-branch deep learning approach," Information 

Sciences, vol. 702, June 2025, Art. no. 121888, doi: 10.1016/j.ins.2025.121888. 

3.2 General principles of referencing 

Data and viewpoints based on previously published sources are commonly used as source material 

in academic work. In accordance with the Copyright Act (Autoriõiguse seadus), all data, opinions, 

and other intellectual property created by other authors must be properly cited when used in written 

work. Submitting someone else's work under one's own name or intentionally using parts of it without 

appropriate academic referencing is considered plagiarism and, according to the Study Regulations, 

may be regarded as academic fraud (Estonian Aviation Academy, 2025). 

In-text references and the reference list at the end of the written work together form a complete 

reference system. The reference list must include all sources cited in the text, and conversely, every 
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source listed must be cited in the text. Linguistically, references are presented in their original 

language. 

Materials of other authors are generally incorporated into academic work through referencing, less 

frequently, through direct quotation. Referencing involves paraphrasing or summarising the author’s 

ideas in one’s own words. A quotation is a verbatim excerpt from another author's text and must be 

enclosed in quotation marks. In the case of a long quotation (more than 40 words), quotation marks 

are not added, and the quotation is presented as a separate paragraph. If a quotation is shortened, the 

missing section is indicated by an ellipsis enclosed between slashes /.../ (Example 7). 

Example 7. Shortening a quote in the text 

APA: "Displaying Air Force surveillance information /.../ is important for us to be able to increase 

the safety level of the service" (Tamm 2025, p. 88). 

IEEE: "Displaying Air Force surveillance information /.../ is important for us to be able to increase 

the safety level of the service" [3, p. 88]. 

Direct quotations should generally be used sparingly and only when their inclusion can be clearly 

justified. Appropriate reasons include instances where the original wording has particular stylistic or 

aesthetic value; where the exact phrasing must be preserved for analytical purposes (for example, 

when examining sentence structure); or where paraphrasing may risk altering the essential meaning 

of an idea. 

References must be presented with sufficient clarity to enable the reader to identify the source of 

each idea. If a reference applies to a single sentence, it is placed immediately after the relevant 

statement, before the sentence-ending punctuation. When an entire paragraph is based on a single 

source, the reference is placed at the end of the final sentence, before the last sentence-ending 

punctuation. In-text citations may also be placed in the middle of a sentence when it helps make the 

source of a particular piece of information clearer, or when the placement fits the sentence structure 

more naturally. For quotations, the citation must follow immediately after the closing quotation 

marks, regardless of its position within the sentence, and must include the page number from which 

the quote is taken.  

If the information in a single paragraph is drawn from multiple sources that all support the same 

point, references to all sources should be added at the end of the paragraph, separated by a semicolon 

(APA) or a comma (IEEE) before the last sentence-ending punctuation, and arranged either 

alphabetically or chronologically. However, if different statements within a single paragraph 
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originate from different sources, a corresponding reference must be added to each statement to ensure 

it is clear which idea comes from which source. 

When preparing written academic work, primary sources – those in which the information, idea or 

result was originally published – should be used whenever possible. Secondary or indirect sources 

are permitted only in exceptional circumstances, such as when the original source is not reasonably 

accessible (located in an inaccessible archive, written in an unknown language, sold out, etc.). In 

such cases, the in-text citation must clearly indicate both the secondary work used and the primary 

source. However, only the secondary source is included in the reference list (Example 8). Although 

the official IEEE referencing style does not permit citing secondary sources, this guide permits it in 

exceptional cases. 

Example 8. Referencing a secondary source 

APA: 

Early studies indicated that the workload of pilots increases significantly during failures in 

automation systems (Johnson, 1995, cited in Collins, 2020). 

Collins (2020) refers to a study by Johnson (1995) according to which the workload of pilots 

increases significantly during failures in automation systems. 

List of references includes:  

Collins, P. H. (2020). Automation Max: Optimizing AI and human intelligence in aviation. Algora 

Publishing. 

IEEE: 

Johnson argued as early as 1995 that the workload of pilots increases during automation failures, and 

this is further discussed by Collins [4]. 

in the list of entries used:  

[4] P.H. Collins, Automation Max: Optimizing AI and Human Intelligence in Aviation. New York, 

USA: Algora Publishing, 2020. 

3.3 Artificial intelligence 

The use of artificial intelligence (AI) is permitted at the Estonian Aviation Academy, provided that 

it is applied purposefully and ethically, the use is transparent, and the information obtained is 

critically evaluated. However, instructors may provide specific guidance in their subjects or 

assignments that differs from the general rule (e.g., limit or prohibit the use of AI). For more 

information about the use of AI in the Academy, please see the Academy’s homepage. 
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Referencing is not required if artificial intelligence has been used as a tool (e.g., for text editing, 

translation, or brainstorming). In such cases, the role of AI is comparable to that of a grammar checker 

or translation engine. However, if the output generated by an AI application is used substantively 

(e.g. a text passage, an image, code, etc.), the application must be cited. Where relevant, it is 

recommended to describe the extent and manner in which AI was used in preparing the work. 

In an academic context, AI conversations should not be treated as personal communication, as this 

does not allow for sufficient transparency or verifiability. Content generated by a text-based AI is 

not permanently published, but depends on a model that changes over time, which is why clear 

referencing rules must be followed when using such content. 

There are two acceptable approaches to refer to the use of AI: 

 referencing a recorded (Shared) conversation generated by AI (Example 9), 

 referring to artificial intelligence as a tool when a specific conversation is not used, but the 

application has contributed to the substantive completion of the work, and it is necessary to 

highlight it (Example 10). 

Example 9. Referencing an AI-generated text 

APA (McAdoo et al., 2025): 

In the text: ChatGPT's responses revealed... (OpenAI, 2025). 

List of references includes:  

OpenAI. (2025, August 21). High school grammar concepts [Generative AI chat]. ChatGPT. 

https://chatgpt.com/share/68a77b60-0ee4-800c-9acc-cd3fd573c311 

IEEE: 

In the text: ... as described by [5]. 

[5] OpenAI, “High school grammar concepts” [Generative AI chat], ChatGPT. Accessed: Sept. 17, 

2025 [Online]. Available: https://chatgpt.com/share/68a77b60-0ee4-800c-9acc-cd3fd573c311 

Example 10. Referencing the text bot as a tool 

APA (McAdoo et al., 2025): 

OpenAI. (2025). ChatGPT [Large language model]. https://chatgpt.com/ 

Anthropic. (2025) Claude 4 Sonnet [Large language model]. https://claude.ai/new 

In IEEE style, referring to an artificial intelligence as software (IEEE, 2025, pp.18-20): 

OpenAI. ChatGPT. (Version GPT-5.2 Thinking). Accessed: Oct. 23, 2025. [Online.] Available: 

https://chatgpt.com  
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3.4 Managing citations 

There are several technical tools available for managing references. You can use the built-in reference 

management features of MS Word or separate reference management software such as Mendeley, 

Zotero, etc.  

In MS Word, reference entries can be managed using tools located under References → Citations & 

Bibliography. Use Insert Citation to add a reference, Manage Source to manage reference entries, 

and Bibliography to create a list of references. 

A reference manager is a software package that enables users to collect, organise, and use 

bibliographic references. Reference managers can usually be "connected" directly to word processing 

software or web browsers. When the code associated with a given reference is entered, reference 

managers can automatically create bibliographies formatted according to the specific requirements 

of a journal or style guide. 

Mendeley (mendeley.com) is a reference manager developed by Elsevier, which allows users to: 

● create a collection of references that are easy to organize and manage, 

● read, annotate, and add notes or comments on PDFs attached to references, 

● easily insert in-text citations while writing and generate a list of cited sources with a single 

click, 

● collaborate with others in their field of research (e.g., work with a supervisor), create a 

research group, or join existing research groups (Tallinn University Academic Library, n.d.). 

Mendeley's English-language guides are available at: http://community.mendeley.com/guides.  
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4 FORMATTING THE PARTS OF WRITTEN ASSIGNMENTS 

This chapter provides detailed guidance on the formatting of specific structural elements of written 

assignments. The instructions below complement the general formatting requirements and must be 

followed consistently throughout the work to ensure clarity, uniformity, and compliance with the 

Academy’s standards. 

4.1 Abbreviations 

It is recommended to abbreviate long names and terms if they are used repeatedly in the text. Before 

an abbreviation is introduced, the full term must be written out in the text, followed by the 

abbreviation in parentheses (Example 11). Thereafter, only the abbreviation should be used 

consistently.  

If there are more than ten abbreviations in the written work, they must be presented separately in a 

list of abbreviations at the beginning of the work, together with their explanations (see the format of 

the list from the “Abbreviations” section of this guide). Commonly used abbreviations are not 

included in the list (Erelt, Erelt, & Ross, 2007). 

Example 11. First use of an abbreviation in text 

The Instrument Landing System (hereinafter referred to as ILS) is a navigation system used in 

precision approach. 

4.2 Lists 

At each level of a list, there must be at least two sub-items. A uniform style of lists must be used 

throughout the work. It is not appropriate to begin or end a chapter or subsection with a list. When 

compiling a list, attention must be paid to how the list is integrated into the surrounding text in a natural 

and coherent manner.  

Lists may be formatted using numbers, lowercase letters, or bullet points. When formatting lists, the line 

spacing must be 1.5 and paragraph spacing 0. Excessive use of lists should be avoided. If a list consists 

of single words or short phrases, the items in the list are separated by commas (Example 12). 

Example 12. List 

To compete for a student place at the Academy, the candidate must meet the following requirements: 
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● have completed secondary education or hold an equivalent foreign qualification, 

● apply for admission within the timeframe, 

● meet the language proficiency requirements. 

If even one item in a list contains comma(s) or other punctuation, semicolons must be used to separate 

the items. In such cases, list items begin with a lowercase letter, and the sequence is marked using 

numbers or letters enclosed in round brackets. 

If at least one item in the list consists of two or more sentences, the bracket following the sequence 

marker is replaced by a full stop. If a list item itself contains a subordinate list, the items of the main 

list must be marked with numbers, while items of the subordinate list are marked with letters. 

Lists may also be presented in-text, provided that the list is preceded or followed by an explanatory 

text to avoid ending a subsection with a list (Example 13). 

Example 13. In-text list 

For the work to be correctly formatted, the following must be used: 1) the instructions for formatting 

written works, 2) the MS Word environment for writing, and 3) appropriate software for preparing 

drawings. 

4.3 Tables 

Tables are used to present numerical data and important textual information in a clear and structured 

manner. The data presented in a table should complement the main text rather than repeat it. Each 

table must be referenced in the text. 

All tables included in a written assignment must be labelled using the word “Table” and numbered 

consecutively either throughout the entire work (when up to ten tables are used) or within individual 

chapters, if the number of tables is larger. For example, “Table 1.” or “Table 3.4.” It is recommended 

to use the same numbering principle for figures and formulas to maintain consistency.  

Formatting tables (Example 14): for labelling and automatic numbering of tables, it is recommended 

to use MS Word function References → Insert Caption. Table titles are formatted using the Caption 

style, font size 12pt, line spacing 1.5, paragraph spacing 6pt, and alignment to the left. The table title 

must be informative and, if necessary, clearly indicate the source of the data used. A full stop is not 

added to the end of the table title. Text inside the table must be written in the same language as the 

main text of the work, using a font size between 10pt and 12pt and single line spacing. When referring 

to a table in the main text, the MS Word function References → Cross-reference must be used. This 

ensures that in-text references to tables remain accurate and are updated automatically if table 

numbering changes. 
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Example 14. Formatting a table 

Table 1. Average monthly gross wages and salaries in 2021–2024, in euros (Statistics Estonia, 2025) 
 

 2021 2022 2023 2024    

I quarter 1406 1536 1741 1894    

II quarter 1476 1666 1872 2007    

III quarter 1463 1641 1812 1959    

IV quarter 1548 1735 1904 2062    

Tables must fit on a single page whenever possible. Large data tables should be placed in the annexes. 

If a table extends over several pages, the header row must be repeated at the top of each page (Repeat 

header rows). 

When additional explanations are required, they are provided immediately below the table. The 

explanatory text begins with the word Note, followed by a full stop and the explanation. If more than 

one explanatory note is included, the heading Notes: is used, followed by a colon, and each note is 

presented on a new line (Example 15). 

Example 15. Table with additional notes 

Table 2. Graduation percentage of students in 2011 - 2016 [2] 
 

 2011 2012 2013 2014 2015 2016  

First half of 
the year 

60 45 100 65 120 40 
 

Second half 
of the year 

3 - 0 12 5 … 
 

Notes: 

1. The symbol "-" indicates that the data could not be verified due to its absence. 

2. The sign "..." indicates that the information is still being collected and cannot be submitted at the time of writing. 

4.4 Figures 

Figures include illustrations, diagrams, graphs, maps, technical drawings, diagrams, schematics, 

images, or photographs. Each figure must have a title, which is placed below the figure, and full stop 

is not added in the end. All figures are numbered similarly to tables. For labelling and numbering 

figures, the MS Word function References → Insert Caption must be used. The label Figure is 

applied, followed by a number and a dot. The title starts with a capital letter. The figure title is written 

in a font size of 12 pt, with line spacing of 1.5, and aligned to the left. A 6-point space must be left 

between the title and the figure (Example 16). 

The texts within the figure are written in the same language as the main text of the work. The figure 

must be clearly understandable even without the main text (including legends, axes, labels, and 
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symbols); however, the title is not duplicated in the figure. Each figure must be referred to in the text 

of the work using References → Cross-reference. The appropriate placement of the figure in the text 

is after the in-text reference. Similarly to tables, the source of the data used must be indicated next to 

the figure title, if necessary. As a rule, figures prepared by the author are used. The data in the figures 

collected by the author is not cited. 

Example 16. Preparation of the figure 

 

Figure 1. Google Share Price in January 2023 (Alphabet Inc. (GOOGL), 2023) 

When preparing technical drawings, the guidelines of this thesis formatting guide and the 

applicable standards must be followed. Additional information can also be found in the 

“Mehaanikainseneri käsiraamat”, original title Mechanical and Metal Trades Handbook (Gomeringer 

et al., 2022), and various CAD software document formats, etc. 

The image presented in the figure should optimally cover up to two-thirds of the figure, including 

the dimensions and symbols provided. Standard dimensions of drawings are given in ISO 5457. 

Standard paper formats are used in either horizontal or vertical orientation and include frame lines, a 

title block, and a binding margin. The frame line is a continuous thick line with a minimum thickness 

of 0.5 mm. The distance from the edge of the paper to the frame line (for A4, A3, and A2 formats) 

must be at least 10 mm; for larger formats (A1 and A0), at least 20 mm. The distance of the frame 

line from the binding edge must be at least 20 mm. The title block is in the lower right corner of the 

drawing, aligned with the frame line. As the standards provide only general recommendations for 

title block design, the minimum requirements applied at the Estonian Aviation Academy are shown 

in Figures 2 and 3 (depending on what needs to be presented). 
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Figure 2. Corner elements in A4 format. A - Logo, B - Symbol 

 

Figure 3. Corner elements in A4 format. A - Logo, B - Symbol. 
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If a drawing has several pages, the pages are separated by a slash, e.g. 1/6. The size of the 

part/assembly is defined by scale and is written in the Dimension box. In the title block, the scale is 

written numerically and is defined by the ISO 5455. For example, the preferred scale ratios for 

displaying an object are: 

1) when scaling up: 2:1, 5:1, 10:1, etc. 

2) when reducing: 1:2, 1:5, 1:10, etc. 

When choosing the scale, it must be ensured that the drawing is legible and that all important parts 

remain within the frame lines and are correctly visible.  

The types and uses of lines are defined by the ISO 128. Drawings use two lines of different 

thicknesses: a thick line and a thin line, whereas the ratio between these two lines must be at least 

2:1. Line thicknesses are specified as follows: 0.13, 0.18, 0.25; 0.35; 0.5; 0.7, 1.0; 1.4 and 2.0 mm.  

Technical drawings use the standard lettering specified in ISO 3098-1:2015. The font size is given 

in millimetres, and italics may be used where necessary. 

The drawing must convey the essence of the product and all information required for its manufacture. 

To achieve this, as many projections as necessary must be included to define the shape of the product. 

For example, several rotational bodies can be defined using a single projection (e.g. simple shafts or 

bushings), whereas more complex products, such as housings, require additional views.  

4.5 Formulae 

Formulas and the symbols used in them are written in italics, using font size 12pt. Formulas must be 

formatted using the equation editor (Insert → Equation). All formulas are numbered in the work, and 

the formula number is placed in parentheses on the same line as the formula, preferably aligned to 

the right. Formula numbering may follow either a simple numbering (Example 17) or a composite 

numbering system (Example 18). Both systems are permitted; however, one system must be used 

consistently throughout the entire work. 

Units of measurement are not included in the formulas themselves. Instead, they are provided in the 

explanations of the symbols used in the formulas and are written in vertical font. The explanation of 

symbols in the formula begins with the word "where" (without the following colon). For clarity, the 

explanations are presented either on separate lines (Example 17) or as continuous text (Example 18). 

In each new formula, only symbols that appear for the first time are explained. 

Example 17. Formula with simple numbering 

The wavelength (λ) is expressed by the following formula: 

𝜆 =  
௖

௙
, (1) 
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where  λ – wavelength, m;  
 

 c – speed of light, m/s;  
 

 f  – frequency, Hz. 

Example 18. Formula with composite numbering 

The tensile stress (R) is expressed by the following formula: 

𝑅 =
ி

ௌబ
 , (1.2) 

where R is the tensile stress, N/mm2; F is the force of attraction, N; S₀ is the initial cross-sectional 
area of the specimen, mm2. 

4.6 Annexes 

The annexes include figures, data and materials that are important for addressing the research 

problem but are not essential for inclusion in the main text, or that are very extensive in volume (e.g. 

research support materials, questionnaires, tables). All annexes must be referred to in the main text. 

The annexes are numbered using Arabic numerals in the order in which they are referred to in the 

text, followed by the title of the annex aligned to the left (Example 19). A full stop is not added at 

the end of the title. Each annex begins on a new page. If the text, image, table, or other material 

included in the annex is not created by the author of the work, its origin must be indicated with an 

accurate source reference. 

Example 19. Annex 

Annex 1. Sample title page 

The list of the titles of the annexes is not included in the table of contents. The first annex must be 

preceded by a page entitled 'Annexes' which includes a list of annex titles (see Annexes). To format 

annexes in MS Word, use References → Insert Caption, with the label "Annex". To generate a list 

of annexes, use Insert Table of Figures. 
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Annex 1. Title page format 

Estonian Aviation Academy 
….. Curriculum 

 

Forename Surname 

TITLE OF THE WRITTEN ASSIGNMENT  

Thesis / Research / Abstract / Report 

Supervisor: Forename Surname 

Consultant: Forename Surname 

Tartu County 2025  
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Annex 2. Title page of a thesis with access restrictions 
FOR INTERNAL USE 

Order of the Vice Rector for Academic Affairs No. xxxx, dd.mm.yyyy 
Name of the information holder: Estonian Aviation Academy 

Basis for restriction of access: § 35 (1) clause 17 of the Public Access Act 
Start date: dd.mm.yyyy 
End date: dd.mm.yyyy 

 

Estonian Aviation Academy 
….. Curriculum 

 

Forename Surname 

TITLE OF THE WRITTEN ASSIGNMENT  

Thesis / Research / Abstract / Report 

Supervisor: Forename Surname 

Consultant: Forename Surname 

Tartu County 2025  
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Annex 3. Author's declaration and supervisor's confirmation of admission to the defence of the thesis 

 

Author’s declaration 

I confirm that I have prepared the thesis independently. All works by other authors, fundamental 

views, and data obtained from literary or other sources and used in the preparation of this work have 

been properly cited. 

 

/digitally signed/ 

Author: Forename Surname 

 

Supervisor's confirmation for defence 

I confirm that the thesis meets the requirements for graduation theses at the Estonian Aviation 

Academy. 

/digitally signed/  

Supervisor: Forename Surname 
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Annex 4. Author's declaration and supervisor's confirmation of admission to the defence of the thesis 
for collaborative work 

 

Declaration of Authors 

We confirm that we have prepared the thesis independently. All works by other authors, fundamental 

views, and data obtained from literary or other sources and used in the preparation of this work have 

been properly cited. 

When preparing the thesis, the tasks were divided between the authors as follows: 

 Description of author A's works 
 Description of author B's works 
 Description of the work done together 

The completed work is shared between two authors. The distribution of tasks is presented in Table 

X: 

Table X. Distribution of work between authors 

Description of work Author A Author B 

 

/digitally signed/ 

Author A: Forename Surname 

Author B: Forename Surname 

 

Supervisor's confirmation for defence 

I confirm that the thesis meets the requirements for graduation theses at the Estonian Aviation 

Academy. 

/digitally signed/  

Supervisor: Forename Surname 
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Annex 5. Summary in Estonian1 

 

KOKKUVÕTE 

Title of the thesis in Estonian 

The summary provides a brief overview of the thesis and introduces its key aspects to a reader who 

is not familiar with the full text. It must concisely state the purpose of the work, outline the research 

problem or topic, and indicate the research method or approach used. 

The content of chapters (in the list format): 

Esimeses peatükis kirjeldatakse / käsitletakse / analüüsitakse / uuritakse / tutvustatakse etc. 

The summary must highlight the main findings or results of the study and, where appropriate, indicate 

how these results may be applied in practice or used in further research. 

Expressions of gratitude or acknowledgements are optional and should be included only if they are 

relevant and concise. 

 

  

 
1

 Impersonal – "Töö autor" 
Present tenses and passive used 
To add more points: Lisaks, Peale selle, Samal ajal, Ühtlasi, Lisaks eelnevale, Täiendavalt võib välja tuua … 
To introduce contrasting viewpoints: Samas,  Kuigi, Sellegipoolest, Vaatamata (sellele), Teisest küljest, Teisalt, Vastupidiselt … 
To introduce examples: Nagu näiteks, Konkreetsemalt, Näitena võib tuua, Sealhulgas, Illustreerimaks eelnevat … 
To conclude: Kokkuvõtteks, Lõpetuseks 
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Annex 6. Non-exclusive licence to reproduce the thesis and make it available to the public 

 

Non-exclusive licence to reproduce the thesis and make it available to the public 

Date in the digital signature 

I, Forename Surname, hereby grant the Estonian Aviation Academy a free, non-exclusive licence 

to the work created by me, 

TITLE OF THE THESIS 

supervised by Forename Surname, 

1. for the purposes of reproduction for preservation and making the work available to the public, 

including depositing it in the digital archive of the Library of the Estonian Aviation Academy, 

for the full term of copyright protection. 

2. I am aware that the rights specified in clause 1 also remain with the author. 

3. I confirm that granting the non-exclusive licence does not violate the intellectual property rights 

of other persons or the rights arising from the Personal Data Protection Act. 

 

/digitally signed/ 

Author: Forename Surname  



 

30 

 

Annex 7. Non-exclusive licence to reproduce the thesis and make it available to the public with 
restricted access 

 

Non-exclusive licence to reproduce the thesis and make it available to the public 

Date in digital signature 

I, Forename Surname, hereby grant the Estonian Aviation Academy a free, non-exclusive licence 

to the work created by me, 

TITLE OF THE THESIS 

Supervised by Forename Surname, 

1. for the purposes of reproduction for preservation and making the work available to the public, 

including depositing it in the digital archive of the Library of the Estonian Aviation Academy, 

for the full term of copyright protection. 

2. I am aware that the rights specified in clause 1 also remain with the author. 

3. I am aware that the work has been declared for internal use from dd.mm.yyy based on § 35 (1) 

clause 17 of the Public Information Act and the access restriction is in force for 5 years, i.e., 

until dd.mm.yyyy. If the reason for imposing the access restriction remains, the term of the 

limitation may be extended by up to five years by a decision of the Vice Rector for Academic 

Affairs. 

4. I confirm that granting the non-exclusive licence does not violate the intellectual property rights 

of other persons or the rights arising from the Personal Data Protection Act. 

 

/digitally signed/ 

Author: Forename Surname 
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Annex 8. Non-exclusive licence to reproduce the collaborative thesis and make it available to the 
public 

Non-exclusive licence to reproduce the thesis and make it available to the public 

Date in digital signature 

We, Forename Surname and Forename Surname, hereby grant the Estonian Aviation Academy a 

free, non-exclusive licence to the work created by us, 

TITLE OF THE THESIS 

supervised by Forename Surname, 

1. for the purposes of reproduction for preservation and making the work available to the public, 

including depositing it in the digital archive of the Library of the Estonian Aviation Academy, 

for the full term of copyright protection. 

2. We are aware that the rights specified in clause 1 also remain with the authors. 

3. We confirm that granting the non-exclusive licence does not violate the intellectual property 
rights of other persons or the rights arising from the Personal Data Protection Act. 

 

/digitally signed/ 

Author: Forename Surname 

Author: Forename Surname 
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Annex 9. Sample of a short written paper 

Forename Surname 

x. course 

Name of the curriculum (and 

specialty) 

DD.MM.YYYY 

Lorem Ipsum 

"Lorem ipsum is a pseudo-Latin text used in web design, typography, layout, and printing in place 

of English to emphasise design elements over content. It's also called placeholder (or filler) text." 

[1] 

… 

… [2] 

… 

… 

 

 

Reference 

1. Lorem ipsum. Accessed: 27.11.2023 [Online]. Available: http://generator.lorem-ipsum.info/ 

2. … 

 


